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Using the EyeHarp

For the best EyeHarp experience, you will need an eye tracker. An eye tracker is a special
device, a camera and a dedicated software, that can detect where you are looking at every
moment. It is normally placed under the screen.

We recommend Tobii Eye Tracker 5 as an affordable device with great performance. EyeHarp is
compatible with any device that communicates through the EyeX server. This includes all Tobii
eye tracking consumer devices.

Alternatively EyeHarp can be played with any other device that can control the mouse pointer.
For example, a mouse, a head tracking device, a trackball, or a touch-pad.

You can switch between gaze input and mouse input by pressing alt + m. If no special device is
connected to the computer, mouse input is the default.

Software Registration and Updates

To activate your premium EyeHarp software, select Manage Registration. You will be taken to
an online activation page. Enter the activation key, and click Activate license key:
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Wait for the confirmation message:

Click Finish

Updates

When a new update is available, a notification message will appear on startup. Go to Manage
Registration under the advanced menu to download and install the update.
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Interface

The interaction with the EyeHarp is done by looking at buttons and selecting them. A button in
the EyeHarp interface is a circle with a small focus point in the center. To select a button, look at
the focus point of the button for 1 second. This method is known as dwell time.

Alternatively, the EyeHarp can be configured to perform selection with the mouse pointer
(pressing Alt + m to force mouse input, and Alt + k to switch between dwell time selection and
mouse click selection).

Remember, the notes you play are not buttons. When you look at a note, it will sound instantly
without delay.

EyeHarp has four screens: main screen, catalog, instrumental options menu, and advanced
menu.

The main playing screen shows the note selection area, a colorful pie-like keyboard.

The catalog is where you can select songs from the EyeHarp repertoire, activate or deactivate
the audio and visual guides, and quit the application.

The instrumental options menu is where you can select sounds and their range, apply reverb or
chords, activate volume to distance function, and switch to full screen.

The advanced menu is where you can configure notes and chords settings, define audio and
MIDI output, turn selection sounds on and off, and manage your EyeHarp license.

Playing the EyeHarp

The notes on the circular keyboard are arranged in a scale, and selection depends on direction.
The notes divide the circle into slices, with a specific selection area for each note. This design
improves temporal control, and it is effective for playing free-flowing melodies.

The notes are placed at the perimeter of the pie, with a note selection area of a different color
for each one. The starting note is placed below the gap in the circle. The note names are written
in the inner part of the circle, next to the note selection area.

When looking at each note area, the corresponding note (or chord, if the chord option is
activated) is triggered.
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If you activate the distance to volume option, looking at the outer region of the note area will
produce louder dynamics, and looking at the inner region of this area will produce softer
dynamics. To facilitate dynamic control, four focus points are provided in each note area.

In the inner part of the circle there is a black neutral area where the performer can rest without
turning the note off, and also without triggering any new notes. You can search for the right
notes by looking at the note names while the sound continues.

To stop notes from playing, simply look anywhere outside the circle (release area).

A replay note button, a grey circle in the center of the pie, will appear when playing notes. This
button allows you to easily and quickly play the same note twice consecutively. The same note
can be played again and again just by looking at the selection area of a note, then back to the
center of the pie and so on. The replay note button disappears when looking at the rest area, or
at the release area outside the pie.

It is possible to deactivate or activate the replay note button under the advanced menu.
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Free Mode

In this mode you can play the EyeHarp without assistance from the software, and change the
instrument parameters as you wish.

The default settings are C major diatonic scale (only white keys, in piano terms), with a circle of
12 notes, and a piano sound in the middle octave (starting on C4):

To stop all sounds, select the mute button:

To change the default settings, select settings button:
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Two menus will appear:

Transpose by octaves

Transpose by semitones

Adjust number of notes

Move starting note (in order of the notes in the scale)
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Show or hide semitones
Select scale:

Major

Harmonic minor

Pentatonic

Blues

Hicaz (dominant phrygian mode)

Select chord progressions

Advanced users:

To modify the notes of the scales, or to create new scales, go to the scales.txt file, under the
AppData folder.
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When selecting chords, the interface will show chord letter names, and instead of single notes
EyeHarp will play chords.

The chords, their shown name, and the name of the button are set via the chords.txt file, under
the AppData folder.

Each line of the text file must begin with the button name, then each chord name with its notes
in MIDI values. Each chord must be separated by a comma, no spaces. Notes within the chords
are separated by one space. The chords are shown on the circular keyboard in the same order
they are written in the text file, from left to right.

For example:

chords;I-IV-V,C 60 64 67,F 60 65 69,G 62 67 71

In this example the name of the button will be “chords I-IV-V”. The circular keyboard will show,
and play, C, G, and F in this order.
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Learning Mode

Use this mode to learn how to play melodies from the EyeHarp’s repertoire, with audio and
visual assistance.

To play in Learning Mode, load an EyeHarp music score from the catalog. First, select the
catalog button:

Then, navigate the folders to find the melody you wish to play:

To continue with the selection, use the rightward arrow button:
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To go to back one step, use the leftward arrow button:

After selecting a music score, choose between the three playing option:

Play with rhythm

Playing the melody all at once, in tempo, following the visual and/or audio guides.

Practice without rhythm

Practicing the melody freely, with a visual guide.

Memory game

Listening to parts of the melody, and repeating them.

To switch between the options after a music score was loaded, select the catalog button, and
then the desired option.

To return to Free Mode, select the Play Free button:
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Play With Rhythm

Once a melody is loaded, press play to start playing. Follow the visual guide on the screen, and
the audio guide. You can also turn on error silence, so only the notes that are part of the
melodies are active and the rest of the notes are muted.

The visual guide shows a round chronometer, which indicates the duration of the note, and an
arrow that directs to the following note:

The audio guide includes a metronome and a playback of the melody.

You can activate or deactivate each of these guides and silence errors under the catalog menu:

If the button is highlighted, the option is activated (and vice versa).

Transpose the melody by semitones (+ raises by one semitone, - lowers by one semitone):

On the playing screen, adjust the tempo (+ raises by 5 BPM ,- lowers by 5 BPM) :

When you finish playing the melody, you will receive the performance stats, including a
percentage score.
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Practice Without Rhythm

Use this option if you wish to practice a melody freely, without metronome and without receiving
a score for your performance. Once a melody is loaded, press play to start practicing.

When practicing, only the visual guide is activated, and the metronome is off. The visual guide
follows you. It shows the next note after you play the current note.

When silence errors is turned on, only the notes that are part of the melodies are active, and the
rest of the notes are muted:

To go back to the previous note, use the undo button:

In the playing screen, you can choose the starting position of the melody:

The start position moves by the number of notes per step.
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To change the number of notes by which the starting position moves, adjust the notes per step
option in the catalog menu:

To stop the sound all together, select the mute button:
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Memory Game

In the memory game, EyeHarp will play the melody in steps of a few notes at the time, and the
player needs to repeat the notes, until the melody is completed. Each new step of the melody is
added to the previous ones.

Here only the visual guide can be used:

Arrows indicate the next note; the ordinal number of the note is shown as well:

The numbers indicate the overall progress.

With every new step, you need to press play to restart the melody again with the new step.
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Playing a correct note will show a green checkmark with the number of the note:

And playing a wrong note will show a red X in the middle:

If you make a mistake, you have to start over.

When each step of the melody is played correctly, a blue checkmark will appear in the middle:

When the melody is finished, a green double checkmark will appear in the middle:
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If you want to practice more before continuing the game, simply deactivate the mute button:

In the game, you can also choose the starting position of the melody:

The start position jumps by the number of notes per step.

Adjust the number of notes played in each step in the catalog menu:
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Sound
The premium version of the EyeHarp comes with a bank of instrumental sounds. The default is
piano.

To change sound, go to the instrumental options menu:

Note that this button changes according to the current selected instrument.

Select your desired instrument:

The selected instrument is highlighted (in this picture, piano is selected).

The thick circle indicates instruments that can be used as the audio guide sound. To change the
audio guide instruments, select the instrument twice - one time to highlight it and a second time
to set it up as the audio guide sound. After the second time, the background of the selected
instrument will be grey (like the marimba in the picture above).
Volume
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To adjust the volume, select the volume button:

Upon selection, the following options will appear on the screen:

Master volume

User volume

Audio guide volume

Metronome Volume

+ to increase the volume, and - to lower the volume. The range of all the options is 0-20.

To hide the volume options, select the volume button again.
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More Instrument Options

Activate or deactivate the distance to volume option. When activated,
looking at the outer region of the note area will produce louder
dynamics, and looking at the inner region of this area will produce softer
dynamics (see Playing the EyeHarp section).

Activate or deactivate reverb effect.

Play each note as a chord. The default is a triad (based on scale
degrees). You may change the notes of the chords under advanced
settings.

If the button is highlighted, the option is activated (and vice versa).

Adjust the range of the instrument:

Raise by one octave

Lower by one octave

Range of EyeHarp instruments corresponds to their true range.
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MIDI

EyeHarp can also function as a MIDI controller, with any VST plug-in. You can set any
instrument and sound in the VST plug-in, such as Kontakt, with one sound per MIDI channel.

Remember, a MIDI controller does not produce any sound. It only sends control messages to
another external synthesizer or virtual instrument.

To send MIDI from EyeHarp, activate MIDI OUT in the settings.

To change the MIDI channel, select a different instrument from the instrument options menu.
The channels are ordered from left to right, starting from the top left. So piano is channel 1,
drum kit is channel 2, flute is channel 3, and so on. The free version is limited to channel 1 only.

In some cases, like when sending MIDI to a DAW, a virtual MIDI port is required. We
recommend LoopMIDI, a free virtual MIDI port.

In LoopMIDI, create a new MIDI port called eyeharp (single word, all lowercase). EyeHarp will
automatically identify this MIDI port. Also, make sure to deactivate the feedback-detection,
under the LoopMIDI Advanced tab.

In addition, you can use additional MIDI controllers with EyeHarp. When MIDI out is activated, a
selection of controllers will appear:

To change the default MIDI controllers, you would need to edit the setting.txt file, located in the
AppData folder. In this text file, find a line that says midicc_distance. The two numbers after it
refer to the MIDI controllers. Edit these numbers according to the CC you need. This works in
both the free version and premium version.
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Advanced Settings
Access the advanced settings through the instrumental options menu, selecting the cog button:

Audio and Sound Settings

Select sound Activate or deactivate
card MIDI output

Select chord notes or type of chord (when playing chords is activated):

The highlighted intervals will be included in the chord (and vice versa).
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EyeHarp Appearance and Control

● Clock with Mouse: Switch between dwell time or mouse left-clicks button selection.
When this option is highlighted, selecting buttons in the app is done by clicking with the
mouse. When this option is not highlighted, selecting buttons in the app is done by dwell
time (the default mode).

● Lyrics on Notes: Shows lyrics when playing songs. Only for songs that have lyrics
written in their score.

● ABC Notation: Choose between ABC notation and solfege notation. When ABC
notation is selected, the notes in the circle will show as C, D, E, etc. When ABC notation
is off, the notes in the circle will show as do, re, mi, etc.

● Dwell Time Notes: Activate or deactivate the option to select notes on the circular
keyboard with dwell time, the same way as buttons

● Ignore 150ms after Blink: Ignores the first 150 milliseconds after the gaze is lost (which
happens after a blink). Might reduce responsiveness.

● Replay Same Notes ON/OFF: Activate or deactivate the repeat note button in the
center of the circle.

● Rotate -90: Rotate the EyeHarp circle by 90 degrees so the starting note is on top.
● Short Line: Use a short line for the visual guide.
● Flashing Visual Help: Makes the visual guide flash in red.
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1 2 3 4 5 6

1. Adjust the sensitivity of dynamic control (when distance to volume is activated). Higher
velocity sensitivity (max. 3) will expand the dynamic range of each note button. Lower
velocity sensitivity (min. 1) will reduce the dynamic range.

2. Adjust the amount of dwell time in milliseconds needed to select buttons.
3. Adjust the duration the button is still active.
4. Adjust the radius of the semitones.
5. Adjust the radius of the inner EyeHarp circle.
6. Adjust the radius of the outer EyeHarp circle.

When adjusting to the radius, a circle will appear on the screen to show the new size:

23



Other Software Settings

Calibrate Tobii eye tracker directly from EyeHarp:

Restore all settings to default (requires to select twice):

Software updates or manage license:
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Keyboard Shortcuts

Below, EyeHarp key commands listed according to category. Pressing ‘alt + h’ will display the
keyboard shortcuts on the EyeHarp.

General

Alt + h Show or hide shortcuts

Alt + m Switch between mouse and gaze control

Alt + k Disable or enable dwell time button selection

Shift + F Full screen on or off

Alt + n Show or hide gaze indicator

4 Octave up

r Octave down

5 Transpose half-step up

t Transpose half-step down

Alt + l (lowercase L) Lock and unlock buttons

Esc Quit EyeHarp

Learning Mode

, Play or restart

. Stop

1 Increase tempo

q Decrease tempo

Shift + H Audio guide on or off

j Visual guide on or off

Alt + Shift + V Slave mode on or off1

→ Next note (only in slave mode)

1 Slave mode can be activated in the play free mode. It allows the music teacher to advance the notes of
the performance using the arrows of the keyboard.
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← Previous note (only in slave mode)

Free Mode

2 Increase number of notes

w Decrease number of notes

3 Starting note up

e Starting note down

Mixer

↑ Master volume up

↓ Master volume down

0 (zero) User volume up

p User volume down

9 Metronome volume up

o Metronome volume down

8 Audio guide volume up

i Audio guide volume down

Advanced

c Increase visual guide speed

d Decrease visual guide speed

Shift + T Flashing target on or off

Atl + v Increase gaze buffer time

Alt + f Decrease gaze buffer time

Alt + Shift + M Metronome view on or off

Alt + Shift + D Show or hide debug info

Shift + C chronometer colors on or off

Alt + r Rotate circle

b Increase dispersion factor
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g Decrease dispersion factor

a Increase circle center radius

z Decrease circle center radius

s Increase outer circle radius

x Decrease outer circle radius

7 Increase maximum key velocity (distance to
center)

u Decrease maximum key velocity (distance to
center)

6 Increase minimum key velocity (distance to
center)

y Decrease minimum key velocity (distance to
center)
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Creating scores
Creating your own EyeHarp scores is done with MuseScore, a free music notation software.

The following is an example of creating an EyeHarp score of Twinkle Twinkle Little Star.

1. First download the song from the MuseScore online database. Download in MuseScore
format and open in MuseScore software.

2. Create a new staff and rename it to “Eye”. This will be the part that the user will play. In
order to create a new staff go to edit → instruments. Then select any instrument, such as
Woodwinds → Flute, and select add to score. For better visualization, move this staff to
the top using the arrow on the right of the screen.
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3. To rename the Flute part to “Eye” double click on the word Flute or right click on the first
bar of the staff and select Staff/Part properties. On the Part name field, replace Flute
with Eye. Optionally, also change the long and short instrument names as well. Then
click on apply and press on the arrow down button at the bottom  left of the window.

4. Change the other instrument names to names that EyeHarp software recognizes, for the
accompanying part in the EyeHarp. Use these specific names:

● Piano
● Drum Kit
● Flute
● Oboe
● Clarinet
● Trumpet
● French;Horn
● Saxophone
● Violin;(arco)
● Violin;(pizz.)
● Cello;(arco)
● Cello;(pizz.)
● Contrabass
● Marimba
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● Harp
● Glockenspiel
● Xylophone
● Vibraphone
● Organ
● Accordion
● Acoustic;Guitar
● Electric;Guitar
● Distortion;Guitar
● Electric;Bass
● Banjo

For better quality, we advise mostly using the instruments that are in bold.

For example, to change the accompanying instrument from piano to harp, simply rename
the part name from Piano to Harp, then press apply and OK.

This is how the score should look now:

5. Copy-paste or create the Eye part. In this example, the Eye part was copied from the
treble clef staff of the harp part. To do that, select all notes of this part and copy them,
then paste in the desired staff.
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6. To keep only the bass clef accompaniment, it is possible to delete the treble clef staff
from the harp part. Go to Edit → Instruments, select the Piano → Staff 1 and click on
Remove from score. Then click on OK.
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The score should now look like this:

7. Save the file in the MuseScore scores folder. Go to File → save and navigate to the
folder you wish to save your MuseScore scores. You will need to open this file again if
you wish to modify the score.

8. For the first time you create a score you will need to make the folder
C:\ProgramData\EyeHarp\ editable. To do that, open windows file explorer and go to C:\.
In the View menu, make sure the option hidden items is enabled. Then double click on
ProgramData. Once in C:\ProgramData, right click on the EyeHarp folder and select
properties. Then select the security tab and click on Edit. Click on Users and click on the
full control / Allow checkbox. In the end click on OK.

9. Create a new folder named myScores under C:\ProgramData\EyeHarp\catalog. Add any
new score to this folder. To create the actual EyeHarp score, a MIDI file and an XML file
are required.

10. To create the MIDI file, go back to MuseScore software and export the new score as
MIDI: File → Export and on the drop down list select MIDI and then click export.
Navigate to the folder C:\ProgramData\EyeHarp\catalog\myscores and place the MIDI
file in there.

11. To create the XML file open the file browser and navigate to
C:\ProgramData\EyeHarp\catalog\myScores. Under View, enable the file name
extensions option. Now from the home tab of the file browser, select new Item → text
document. Name it as 1-Twinkle.xml. The number 1 indicates the difficulty level of the
score.

12. Open the XML file. Editing the XML file can be done with Windows Notepad, but we
recommend installing and using notepad++ to edit the XML files.
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13. Paste the following text into the XML file:

<song>
<level>1</level>
<title>Song Title</title>
<composer>Composer Name</composer>
<midiFile>myMidi.mid</midiFile>
<minimumRest>2</minimumRest>
<mp3File></mp3File>
<mp3OffsetMS></mp3OffsetMS>
<tonality>C</tonality>
<tempo>60</tempo>
<transpose>0</transpose>
<countDown>4</countDown>
<metronome>

<length>4</length>
<loop>

<note> 2,41,0.7,100,1 </note>
<note> 2,44,0.7,80,2 </note>
<note> 2,44,0.7,80,3 </note>
<note> 2,44,0.7,80,4 </note>

</loop>
</metronome>

</song>

14. Replace the required fields in order to match the actual song. In the Twinkle Twinkle
Little Star example it will look like this:

<song>
<level>1</level>
<title>Twinkle Twinkle</title>
<composer>Wolfgang Amadeus Mozart</composer>
<midiFile>Twinkle,_Twinkle,_Little_Star.mid</midiFile>
<minimumRest>2</minimumRest>
<mp3File></mp3File>
<mp3OffsetMS></mp3OffsetMS>
<tonality>C</tonality>
<tempo>60</tempo>
<transpose>0</transpose>
<countDown>4</countDown>
<metronome>
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<length>4</length>
<loop>

<note> 2,41,0.7,100,1 </note>
<note> 2,44,0.7,80,2 </note>
<note> 2,44,0.7,80,3 </note>
<note> 2,44,0.7,80,4 </note>

</loop>
</metronome>

</song>

15. Save the file.

16. Open your song in the EyeHarp and play.

XML File Functions
● level: the level of the song.

● title: the title of the song.

● midiFile: the name of the MIDI file created in MuseScore.

● minimumRest: a number that defines the minimum rest duration in the user’s melody in
beats. For example if minimumRest is set to 2, then any rest smaller than 2 quarters will
be ignored, and its value will be added to the duration of the previous note. This number
can also be a part of a beat, such as 0.66.

● tonality: defines the tonality of the MIDI file. Diatonic notes will appear as normal keys in
the EyeHarp wheel, while the chromatic notes will appear as semitones (circles in the
outer region). The value is based on the alphabetical note names: A B C D E F G. This
corresponds to the major scale of the defined note. The minor scales are defined using
the relative major scale. For example if a piece is in B minor, the right value in the
tonality field would be D.

● transpose: applies a transposition in semitones to the given MIDI file.

● countDown: defines the number of beats that will show up before the song starts.
Works only in the play with rhythm mode.

● metronome: defines a rhythmical loop that would accompany the performance in the
play with rhythm mode. It has two subfields: length and loop.
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● length: defines the length of the loop in whole beats. This value can only be a whole
number.

● loop: defines the musical material of the metronome loop. It contains the note subfields.

● note: defines each note of the loop. It takes 5 values separated by a comma. These
values are: [instrument],[note],[duration],[volume],[onset time]

○ instrument: Defines the instrument by a number in the order that they appear in
the EyeHarp’s instrument catalog (listed above). The common value is 2, which
corresponds to the drum kit instrument.

○ note: MIDI note value, between 0 and 127.

○ duration: duration of the note in beats or part beats.

○ volume: defines the volume (MIDI velocity) of the note in a value between 0 and
127.

○ onset time: defines the starting point of the note in the loop, by beat. Use  values
between 1 to loop length + 1.

Adding a Backing Track MP3
It is also possible to use an MP3 as a backing track, accompanying the performance of the user.
This audio must be recorded using a metronome, otherwise it will not be synchronized with the
performance of the user.

Put the MP3 file in the same folder as the XML file. Insert the name of the MP3 file in the
<mp3File> field.

The field <mp3OffsetMS> is used to set the starting point of the MP3 file in milliseconds. This
allows to remove silence that might exist at the beginning of a recording, and to make sure the
user’s performance starts exactly with the backing track.

35


